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ABSTRACT  
 
The development of new drugs with potential therapeutic applications is one of the most complex and difficult 
process in the pharmaceutical industry. Millions of dollars and man-hours are devoted to the discovery of new 
therapeutical agents. Recently, impressive technological advances in areas such as structural characterization of 
molecules, computer sciences and molecular biology have made rational drug design feasible. The Protein- Ligand 
interaction plays a significant role in structural based drug designing.  Chalcones and their derivates have been 
shown to have potency as anticancer. Chalcone is a flavonoid compound, analogs of this drug molecule were 
selected from published journals and docked with COX-1 (PDB ID: ICQE) using HEX software. Furthermore, these 
docking processes were obtained the lowest scoring value in chalcone-30. The substituent compatibility and then 
ADME properties of the Analogs was analyzed using Insilico.  Analysis of the results of the docking softwares 
suggested that chalcone-30 can act as a potent COX-1 inhibitor, than the screened 50 chalcones. 
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INTRODUCTION 

 
Computational biology and Bioinformatics have the potential to speed up drug discovery processes, reducing the 
costs of the processes and changing the way the drugs are designed. Rational drug design facilitates and speeds up 
the drug designing processes that involves various method of identifying novel compounds. Thus computational 
biology or   Insilico approach is developing day by day with refinement. It is becoming a promising field and with 
the help of this the time and cost of biological work related to drug discovery, molecular interaction is reducing. The 
computational techniques employed to aid the drug design process include virtual screening, docking, and scoring 
with the results or "hits" utilized by medicinal chemists. There are various tools, softwares and servers meant for 
docking calculations [1]. Docking is a technique of placing a drug candidate into the active site of a receptor. The 
docked pose of a ligand in the active site of a receptor can be scored using knowledge-, empirical, or physics-based 
methods with the latter being more expensive [2]. The compounds that make it through docking, scoring, and 
evaluation become drug leads, and are then passed on to undergo drug testing techniques by scientists in a wet lab, 
to ensure that only compounds with effects relatively unique to the target system and safe to the rest of organism are 
considered. However, the drug company has already saved much time and money up to this point by having 
computers do chemical screening, rather than human scientists [3].  
 
Worldwide about 20 million people per year are diagnosed with cancer and more than 6 million mortalities are 
recorded and rate of cancer incidences increases every year. Till date large number of herbal products has been 
screened for their anticancer potential through various experimental models. This has caused the discovery of the 
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several drugs by the pharmaceutical and scientific communities [4]. Cancer is a leading cause of death in developed 
and developing countries. The current research in cancer is focused on the identification of new and unequivocal 
target for the development of novel anticancer agents. Cyclooxygenase (COX) enzymes are widely used to 
determine the anticancer effects of potential therapeutic products [5]. COX-1 and COX-2 are two isoforms of 
Cyclooxygenase, which are involved in the metabolism of prostaglandins by transforming arachidonic acid (AA) 
into PGH2. This enzyme bis-oxygenates AA to PGG2, which is subsequently degraded to vasoactive and 
inflammatory mediators such as prostaglandins (PGs), prostacyclin (PGI2), and thromboxane-A2. Pharmacological 
inhibition of COX can provide relief from the symptoms of inflammation and pain. 
 
Mainly isoform two of Cyclooxygenase (COX-2) is a major therapeutic target for inflammatory diseases since its 
selective inhibition has been shown to prevent prostaglandin synthesis at the inflammatory sites while producing 
reduced gastrointestinal and renal side effects. Indeed, the nonselective COX-2 drugs are inhibiting both the 
constitutive COX-1 isoform, which is involved in the gastrointestinal and renal homeostatic functions, and the 
inducible COX-2 enzyme expressed specifically during the inflammatory events. Most of the research going on 
selective inhibition of COX-2 over COX-1 is beneficial for treatment of inflammatory diseases with reduced 
ulcerogenic side effects. Therefore, selective inhibition of COX-2 over COX-1 is beneficial for treatment of 
inflammatory diseases with reduced ulcerogenic side effects. 
 
But the recent reports shows that inhibition of both COX-1 and COX-2 is important in reduce the production 'Bad' 
prostaglandin. Specific inhibition of COX-2 has been extensively investigated, but relatively few COX-1 selective 
inhibitors have been described. Recent reports of a possible contribution of COX-1 in analgesia, neuroinflammation, 
or carcinogenesis suggest that COX-1 is a potential therapeutic target [6]. 
 
Chalcones are natural or synthetic trans-1,3- diaryl-2-propen-1-ones (Figure 1) belonging to the flavonoid family of 
natural products. Chemically, they contain an open-chain flavonoid skeleton in which two aromatic rings are linked 
by a three-carbon α,β-unsaturated carbonyl system [7]. 
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Fig.1 General chemical Structure of Chalcones 

 
They have been reported to possess many useful properties including anti-inflammatory, antimicrobial, antioxidant 
and anticancer activities, therefore representing a class with enormous therapeutic potential. Anti-inflammatory 
activity of these compounds is manifested by their interaction with a number of targets; some of which include 
inducible nitric oxide synthase (iNOS), nuclear factor-κB (NF-ΚB), heme oxygenase (HO) and cyclooxygenase 
(COX). Among these, cyclooxygenase (COX), also known as prostaglandin H synthase (PGH synthase/PGHS/PHS) 
is a prominent and well studied protein catalyzing the conversion of arachidonic acid to prostaglandin H2 (PGH2), 
the committed step in prostaglandin (PG) biosynthesis [8]. The severe gastrointestinal (GI) side effects of the 
traditional non-steroidal anti-inflammatory drugs (NSAIDs) are attributed to their non- selective inhibition of COX 
[9]. 
HEX is an interactive molecular graphics program for calculating and displaying feasible docking modes of pairs of 
protein and DNA molecules. Hex can also calculate small-ligand/protein docking (provided the ligand is rigid), and 
it can superpose pairs of molecules using only knowledge of their 3D shapes. The HEX docking program was used 
to dock the chalcone molecule with COX-1 protein. The observed results are discussed in this paper. 
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MATERIALS AND METHODS 
 

3.1. TOOLS AND BIOINFORMATICS SOFTWARE'S USED 
The targeted protein (ID: 1CQE), having the resolution of 1.80 Ao was retrieved from the protein data bank (PDB) 
(www.rcsb.org/pdb). The softwares used for the docking studies were, ArgusLab 4.0.1, Chemsketch, Q-site finder, 
Hex 6.3, Discovery studio 4.0, Molinspiration Server, Osiris Property Explorer. 
 
3.2. PROTOCOL FOLLOWED 
 3.2.1. Preparation of Protein 
Retrieval of Protein (PDB ID: 1CQE) from RSCB Brookhaven protein data bank, then hetero atoms (Ligands), side 
chains and water molecule are removed from protein by using Discovery studio 4.0, then it is saved as modified 
1cqe.pdb, active site was identified by      Q-site finder. Active sites are selected and defined as binding site in 
Discovery studio 4.0. and saved as modified 1cqe.ds. 
 
3.2.2. Preparation of Ligands 
A collection of 50 Chalcones molecules from Published Journals, drug bank are selected and their 2D structure was 
drawn and converted into 3D structure in Chemsketch. The selected 3D chalcone was saved as ligand.mol format. 
Geometry and energy optimization were done by PM3 Method by using ArgusLab and saved the Optimized 
structure in Ligand.pdb format. The Protein was visualized in discovery studio 4.0.   
 
3.2.3. Active Site Prediction by Q-site finder 
Q-Site finder is a method for ligand binding site prediction; it works by binding hydrophobic (CH) probes to the 
protein, and finding clusters of probes with the most favorable binding energy. The URL for this database is 
http://www.modelling.leeds.ac.uk/qsitefinder/ [10]. The above URL was browsed.  In the search option 1CQE name 
was typed, enter the 1CQE in PDB ID box. Treat as ligand selection will removes the ligand from the protein before 
binding site analysis, but retained in the final output, then submit the job. 
 
3.2.4. Define Binding Site in Protein 
Discovery studio 4.0 window was opened, open modified 1CQE.pdb. The molecule tree view tool of modified 
1CQE was expanded (located on the left side on the screen) and open up the folder and Right-click on amino acids 
which is predicted by Q-site finder   in the tree view and select the, "Make a Binding site Group from this Residue" 
option. Discovery studio 4.0 will construct a group underneath the Groups folder with the name    "3 MOL" that is 
of type = Binding Site. File > Save as > Select Save as file type in the open dialog Discovery studio 4.0 file 
(*dsv,*.xml) > Type the File name = Modified 1CQE with Binding site.dsv > Save. 
 
3.2.5. Preparation of Ligands 
All the Chalcones (Ligands) used for docking study were selected from Published Journals. The structure of the 50 
Chalcones was drawn by using ChemSketch (ACDLABS 12.0). The ChemSketch, chemically intelligent drawing 
interface freeware developed by Advanced Chemistry Development, Inc., (http://www.acdlabs.com) was used to 
construct the structure of the ligands [11].  ChemSketch window was opened and Ligand Structure was drawn. After 
this it is cleaned  Tool > Clean Structure, followed by Tool > Generate > SMILES Notations, (By this operation, 
Smile notation of drawn structure will be generated and displayed below the drawn structure, it is used to determine 
the molecular properties by Molinspiration server.).  Select the Generated Smile Notation > Cut (Ctrl+X) > Notepad 
new window was opened > paste (Ctrl+V) > Saved as word file. Tool > 3D Structure Optimization > Save > Select 
Save as file type   in the open dialog [MDL Molfiles V2000 (*.mol) ]  > Type the File name = Ligand.mol > Save. 
 
3.2.6. Geometry and Energy Optimization of Ligand 
All  the  quantum mechanical  calculations  of Ligands  and Molecular visualizations were carried out using 
Arguslab 4.0.1. i ArgusLab Window was opened, ii. File > Open > Select file type in the open dialog MDL MOL 
file (*mol) >  Open, iii. Edit > Clean Geometry File > Calculation > Optimize Geometry... > Select. UFF Underneth 
MM > Start.. (UFF: The Universal Force Field of Rappe's and coworkers. This is a molecular mechanics (MM) 
force field and includes parameterization for the entire periodic table). After the UFF optimization, again ligand 
structure is optimized by PM3 method. Calculation > Optimize Geometry... > Click PM3, Molecular orbital and 
Dipole moment > Start. (PM3: The Parameterized Method 3 parameterization of the MNDO method. This is an 
NDDO Semi empirical Hamiltonian). Edit > Save As in both format Ligand.agl and Ligand.pdb [12]. 
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3.2.7. DOCKING BY HEX 6.3 
HEX 6.3 was used as the docking tool, which calculates intermolecular "energies" by adding up all intermolecular 
interactions (e.g. vander Waals, electrostatic) that occur between a ligand and protein target. HEX calculate protein - 
ligand docking, assuming that the ligand is rigid through spherical polar Fourier (SPF) correlations to accelerate the 
calculations in their 3D shapes. In Hex's docking calculations, each molecule is modelled using 3D expansions of 
real orthogonal spherical polar basis functions to encode both surface shape and electrostatic charge and potential 
distributions, it represents the surface shapes of proteins using a two-term surface skin plus vander Waals steric 
density model, whereas the electrostatic model is derived from classical electrostatic theory. (Protein Docking Using 
Spherical Polar Fourier Correlations Copyright 1996-2010 David W. Ritchie) [13]. Hex manual window was 
opened, from the file, both receptor and ligand separately were opened from the path location defined. By the option 
control, docking was selected and activated. Lastly the binding energy (AE) produced by docking action was saved 
carefully. The docking complex was saved from the file option in the .pdb format for future analysis. 
 
3.2.8. MOLINSPIRATION  
The   URL   for   this   database   is   http://www.molinspiration.com/cgi-bin/properties [14].  The above URL was 
browse, in the Enter SMILES box option, smiles of chalcones is pasted which is saved in Notepad. Enter Calculated 
Properties and Predict Bioactivity option. Properties of chalcones will be displayed & collect the data. 
 
3.2.9. OSIRIS PROPERTY EXPLORER 
The OSIRIS Property Explorer (March 26th, 2014: Version 2 has been published) lets you draw chemical structures 
and calculates on-the-fly various drug-relevant properties whenever a structure is valid. Prediction results are valued 
and color-coded. Properties with high risks of undesired effects like mutagenicity or a poor intestinal absorption are 
shown in red. Whereas a green color indicates drug-conform behavior [15]. In certain cases, you must allow to run 
this applet - for example by clicking the "no entry" symbols. The updated version now predicts logP more accurately 
and converts SMILES strings and compound names into structures. 
 

RESULTS AND DISCUSSION 
 

4.2. MOLECULAR PROPERTIES PREDICTION  
4.2.1. Molinspiration 
The chemical names of selected 50 chalcones are tabulated in the table 1. Physicochemical parameter such as TPSA 
(Topological polar surface area), MW (Molecular weight), and Drug Likeness & LogP (octanols /water partition 
coefficient) was calculated by the methodology developed by Molinspiration software. These Parameters play a vital 
role in generation and determination of bioactivity of chemical entity. 
 
The molecular descriptor study was performed on basis of "Lipinski's Rule of Five" using the Molinspiration server. 
Lipinski's Rule of Five is a rule of thumb to evaluate drug likeness or determine if chemical compound with a 
certain pharmacological or biological activity has properties that would make it a likely orally active drug in 
humans. The rule was formulated by Christopher A Lipinski. The Rule describes molecular properties important for 
a drugs pharmacokinetics in the human body, including their absorption, distribution, metabaolism and excretion 
("ADME"). Lipinski's Rule of Five states that, in general, an orally active drug has [16]: 1. Not more than 5 
hydrogen bond donors (OH and NH groups). 2. Not more than 10 hydrogen bond acceptors (notably N and O). 3. 
Not more than 15 Rotatable bonds (nrotb). 4. A molecular weight under 500 g/mol. 5. A partition coefficient log P 
less than 5.  
 
Software Version: Molinspiration property engine v2013.09 
The following result are obtained from molinspiration server. The table 2 shows that the calculated property of 
chalcones through molinspiration server. The calculated value of logP, TPSA, natom, MM (g/mol), Non, nOHNH, 
nviolation, Nrotb and Volume of reported. All the selected chalcones obey the liplnski rule and have drug likeness 
property. Where LogP- Octanal /water partition coefficient, natom- No.of atoms other than hydrogen, nOH- No.of 
hydrogen bond, nON-No. of hydrogen bond acceptor, nrotb-No. of rotatable bonds. TPSA - Topological polar 
surface area. 
 
4.2.2. Drug Likeness 
Drug likeliness is a qualitative means of analysis to check whether the given molecule is a drug or not and it is 
defined as a complex balance of various molecular properties and structural features which determine whether a 
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particular molecule is similar to the known drugs.   Activity of all test compounds were analyzed under six criteria 
of known successful drug activity in areas of GPCR ligand, ion channel modulator, kinase inhibitor, nuclear receptor 
ligand, protease inhibitor and enzyme inhibitor by the molinspiration software [17]. Software Version: 
Molinspiration Bioactivity Score v 2011 The following result are obtained from Molinspiration server Table 3  
shows that the bioactivity of 50 chalcones calculated by molinspiration bioactivity score v 2011.0. 
 
4.2.3 OSIRIS Property Explorer 
The OSIRIS Property Explorer is an integral part of Actelion's in-house substance registration system. It lets you 
draw chemical structures and calculates on-the-fly various drug-relevant properties whenever a structure is valid. 
Prediction results are valued and colour coded. Properties with high risks of undesired effects like mutagenicity or a 
poor intestinal absorption are shown in red. Whereas a green colour indicates drug- conform behaviour. The OSIRIS 
property explorer lets you draw chemical structures and calculates on-the-fly various drug-relevant properties 
whenever a structure is valid. The calculated drug -relevant property of 50 chalcones were tabulated in table 4 
almost all the chalcones have drug-relevant property. 
 
4.2.4. Molecular properties by ArgusLab 
The orbital energies of frontier orbitals, namely, highest occupied molecular orbital (HOMO) and lowest unoccupied 
molecular orbital (LUMO) energies of the compounds are critical for pharmacological activity. The prediction of the 
potential energies (EHOMO and ELUMO), geometry optimization of structures were performed by using Argus Lab 
software (Barua et al., 2012, Peng et al., 1995). The knowledge of the shape and electron density of a molecule 
helps to assess the nature of the binding of a drug to target site. The 3D structures of the compounds were geometry 
optimized using PM3 semi-empirical QM method. The Highest Occupied Molecular Orbital (HOMO), Lowest 
Unoccupied Molecular Orbital (LUMO) energy values of 50 chalcones were estimated using PM3 method. 
 
The table 5 shows the electronic parameters of optimized structures. All the chalcones have close relationship and 
drug likeness property. The highest energy gap the chalcone was chalcone-30 and the lowest one was chalcone-46. 
The chalcone-30 also have higher dipole moments than other chalcones. 
 

RESULTS 
 

The docking of chalcones with COX -1 (1CQE) receptor by Hex 6.3 software are tabulated (Table 6). The docking 
energy, no.of H-bonds formed and no.of rotatable bonds are calculated from the docking structure. The observed 
results shows that chalcone-30 have lowest docking energy. The chalcone-30 may be one of the best chalcone to 
inhibit COX-1 activity. These theoretical study may be helpful to clinical study of chalcone against COX-1. The 
order of chalcone docking energy with COX-1 was 30 > 45 > 36 > 31 > 7. 
 
Table 7 shows the interaction site of chalcone with COX-1. the bond distances between the chalcone and the 
interaction COX-1 site were measured and tabulated in the table 7. The highest occupied molecular orbited (HOMO) 
value (-0.377902 a.u), and lowest unoccupied molecular orbital (LUMO) value (-0.086278 a.u) of chalcone-30 was 
reported. This energy value was critical for pharmacological activity. 
 
In the drug bank the search is given for wound healing to find the drugs that are used to treat the disease, nearly 13 
drugs were available (Table 1). Chalcone is the drug which binds on the 1CQE receptor. The chemical structure of 
the chalcones drug is retrieved from the NCBI PubChem compound. Chalcones has molecular weight of 208.26 
g/mol, and 4 Hydrogen bond donor and 5 hydrogen bond acceptor. The chemical structure is then drawn in the 
chemsketch and the data is transferred to mol.page. In the mol.page the search is given to get the hits of the drug 
compound chalcones which are called as ligands. These compound are saved in the PDB - Extension in order to 
perform docking in Hex 6.3. 
 
The docking control is done by using HEX-Tool (Fig: 2). The Hex Message showed the clusters formed and 
maximum and minimum energy during docking process. The maximum clusters are shown by the complex 1CQE 
and (2E)-1-(2,4- dihydrooxyphenyl)-3-(2-hydroxylphenyl)pro-2-en-1-one. (Table 1, Fig. 3) E-Value  -223.70 
Kcal/mol.  
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50 clusters formed during the docking process of the 1CQE and chalcones (Table 1, Fig 3). The docked complex 
were saved as PDB file. The docked complex is then opened in discovery studio 4.0 (Fig 2) and the color is selected 
by chain in order differentiate the helical structure of the 1CQE and chalcone.  
 

 
 

Fig: 2 The hex message after docking which shows the clusters formed and minimum and maximum energy of Chalcone-30 with COX-1 
(1CQE). 

 

 
 

Fig: 3 The docked complex of Chalcone-30 with COX-1 (1CQE) showing the interacting amino acids by discovery studio 4.0. 
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Then the chalcone is selected and the search is given to find the interacting amino acids with the selected angstrom 
units. The Q SITE FINDER is the active site analysis tool (Table 3.1) the PDB -ID of the protein 1CQE is uploaded 
in the Q SITE FINDER. The 3D structure of the protein is viewed along with its   binding pockets. This 1CQE 
protein contains   binding pockets and the amino acids. 
 
Docked pose of cyclooxygenase-1 (COX-1) enzyme with the standard chalcone-30 and 2 amino acid (154SER, 
461GLN) was shown in Fig 3 which demonstrated the binding position of the ligand. The enzyme is yellow dotted 
line showing the polar interaction between ligand and enzyme active site. In most of the protein anti-inflammatory 
compounds have hydrogen bond. The potential binding sites of COX-1 (1CQE) was found that (154SER, 461 GLN) 
amino acid. This proves that the effective binding sites are presented in the selected Chalcone-30. 

 
Table -1 The studied chemical structures  of 50 chalcones 

 
S.No. IUPAC Name S.No. IUPAC Name 
1 (2E)-1,3-diphenylprop-2-en-1-one 26 (2E)-1-(4-hydroxy-2-methylphenyl)-3-(5-methoxy-2-

methylphenyl)prop-2-en-1-one 
2 3-[(2E)-3-phenylprop-2-enoyl]benzoic acid 27 (2E)-1-[3-(2-amino-1-isocyanoethyl) phenyl] -3-(2-

ethylphenyl)prop-2-en-1-one 
3 (2E)-1-(naphthalen-2-yl)-3-(2,4,5-trimethoxyphenyl)prop-

2-en-1-one 
28 (2E)-1-(3-acetylphenyl)-3-(2-ethyl-6-methoxyphenyl)prop-2-en-1-

one 
4 (2E)-3-(2-hydroxyphenyl)-1- 

(naphthalen-2-yl)prop-2-en-1-one 
29 methyl 3-[(1E)-3-(3-formylphenyl)-3-oxoprop-1-en-1-yl]-5-

hydroxybenzoate 
5 (2E)-3-(2,4-dimethoxyphenyl)- 

1-phenylprop-2-en-1-one 
30 (2E)-2-(2-hydroxybenzylidene)- 

1-phenylhexane-1,3,5-trione 
6 (2E)-3-(2,4-dimethoxyphenyl)- 

1-(naphthalen-2-yl)prop-2-en-1-one 
31 (2E)-1-(1,1-diamino-1 5-pyridin-3-yl)-3-[(7R)-2-

oxaspiro[5.5]undeca-3,8,10- 
trien-7-yl]prop-2-en-1-one 

7 (2E)-3-(3-aminophenyl)-1-[6-(trifluoro methyl)naphthalen-
2-yl]prop-2-en-1-one 

32 {3-[(1E)-3-(2-aminophenyl)-3-oxoprop-1-en-1-yl]phenyl}sulfamic 
acid 

8 3-[(2E)-3-(2-hydroxyphenyl)prop-2- 
enoyl]phenyl hydrogen sulfate 

33 (2E)-1-(2-hydroxyphenyl)-3- 
phenylprop-2-en-1-one 

9 (2E)-1-(3-aminophenyl)-3-(3- 
azidophenyl)prop-2-en-1-one 

34 3-[(1E)-3-(3-aminophenyl)-3-oxoprop-1-en-1-yl]phenylthiocyanate 

10 (2E)-1-(2-methoxyphenyl)-3- 
(naphthalen-2-yl)prop-2-en-1-one 

35 (2E)-3-(4-hydroxyphenyl)-1-(2,4,6-trihydroxyphenyl)prop-2-en-1-
one 

11 (2E)-1-(2-ethenylphenyl)-3- 
phenylprop-2-en-1-one 

36 (2E)-3-[4-(3-hydroxypropoxy)phenyl]-1-phenylprop-2-en-1-one 

12 (2E)-1-(2-methylphenyl)-3-(3- 
methylphenyl)prop-2-en-1-one 

37 (2E)-3-(3-ethenyl-4-methylphenyl)-1-(3-hydroxycyclohexa-1,5-dien-
1-yl)prop-2-en-1-one 

13 3-[(1E)-3-oxo-3-phenylprop-1- 
en-1-yl]benzoic acid 

38 (2E)-3-[4-(aminomethyl)-3-fluorophenyl] -1-phenylprop-2-en-1-one 

14 3-[(1E)-3-oxo-3-phenylprop-1- 
en-1-yl]benzaldehyde 

39 (2E)-3-(1,3-dihydro-2-benzothiophen-5-yl)-1-phenylprop-2-en-1-one 

15 3-[(2E)-3-(3-chlorophenyl)prop-2- 
enoyl]benzamide 

40 ethyl 3-[(1E)-3-oxo-3- 
phenylprop-1-en-1-yl]benzoate 

16 4-chloro-3-[(1E)-3-oxo-3-phenylprop-1-en-1-
yl]benzenesulfonamide 

41 (2Z)-1,3-diphenylpent-2-ene- 
1,4-dione 

17 (2E)-1-phenyl-3-(5,6,7,8-tetrahy dronaphthalen-2-yl)prop-
2-en-1-one 

42 (2E)-1-(2,4-dihydroxyphenyl)-3-(2-hydroxyphenyl)prop-2-en-1-one 

18 (2E)-1-(3-chloro-4-nitrosophenyl)-3-phenylprop-2-en-1-one 43 1-(2,4-dihydroxy-6-methylphenyl)-3-(3-hydroxyphenyl)propan-1-
one 

19 N-{2-bromo-6-[(2E)-3-phenylprop-2- 
enoyl]phenyl}acetamide 

44 3-chloro-4-methyl-5-[(1E)-3-oxo-3-phenylprop-1-en-1-yl]phenyl 
cyanate 

20 (2E)-3-phenyl-1-[4-(trifluoromethyl) phenyl]prop-2-en-1-
one 

45 (2E)-1-phenyl-3-[4-(tetrahydro-2H-pyran-2-yl)phenyl]prop-2-en-1-
one 

21 (2E)-1-(4-ethylphenyl)-3- 
phenylprop-2-en-1-one 

46 tert-butyl 3-[(1E)-3-oxo-3- 
phenylprop-1-en-1-yl]benzoate 

22 (2E)-1-(3-methoxyphenyl)-3- 
phenylprop-2-en-1-one 

47 (2E)-3-(1-benzofuran-6-yl)-1- 
phenylprop-2-en-1-one 

23 (2E)-3-(2-hydroxy-5-methylphenyl)-1-(2-
hydroxyphenyl)prop-2-en-1-one 

48 (2E)-1-(3-ethynylphenyl)-3- 
phenylprop-2-en-1-one 

24 (2E)-3-[4-(aminooxy)-2-hydroxy phe nyl ]-1-(4-
chlorophenyl)prop-2-en-1-one 

49 (2E)-3-phenyl-1-[6-(trichloromethyl) pyridin-3-yl]prop-2-en-1-one 

25 (2E)-3-[2-(aminomethyl)-5-chlorophenyl] -1-(3,4-
dihydroxyphenyl)prop-2-en-1-one 

50 (2E)-2-methyl-1,3-diphenylprop-2-en-1-one 
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Table - 2 : Molecular Properties calculation of chalcones by molinspiration server Molinspiration property engine v2013.09 
 

Ligand LogP TPSA(A 2) natom MM(g/mol) Non nOHNH nviolation Nrotb Volume 
1 3.81 17.0 16.0 208.26 1 0 0 3 201.85 
2 3.69 54.37 21.0 252.26 3 1 0 4 228.54 
3 3.76 77.75 23.0 256.39 4 3 0 3 269.89 
4 4.75 37.29 21.0 274.31 2 1 0 3 253.86 
5 3.67 35.53 20.0 268.31 3 0 0 5 252.94 
6 4.85 35.53 24.0 318.37 3 0 0 5 296.93 
7 4.91 43.09 25.0 341.33 2 2 0 4 288.43 
8 0.66 10.9 22.0 320.32 6 2 0 5 258.30 
9 3.88 92.84 20.0 264.28 5 2 0 4 238.03 
10 5.00 26.30 22.0 288.34 2 0 0 4 271.39 
11 4.43 17.07 18.0 234.29 1 0 0 4 229.58 
12 4.63 17.01 18.0 236.31 1 0 0 3 234.97 
13 3.69 54.37 19.0 252.26 3 1 0 4 228.85 
14 3.57 34.14 18.0 236.27 2 0 0 4 220.83 
15 3.26 60.16 20.0 285.73 3 2 0 4 245.66 
16 2.93 77.23 21.0 321.78 4 2 0 4 258.10 
17 4.99 17.07 20.0 262.35 1 0 0 3 258.21 
18 4.31 46.50 19.0 271.70 3 0 0 4 230.21 
19 3.74 46.16 21.0 344.20 3 1 0 4 267.68 
20 4.70 17.07 20.0 276.25 1 0 0 4 233.15 
21 4.72 17.07 18.0 236.37 1 0 0 4 235.21 
22 3.84 26.30 18.0 238.28 1 0 0 4 227.39 
23 3.93 57.52 19.0 254.28 3 2 0 3 234.44 
24 3.66 72.55 20.0 289.71 4 3 0 4 243.67 
25 2.45 83.55 21.0 303.74 4 4 0 4 259.51 
26 3.96 46.53 21.0 282.33 3 1 0 4 268.53 
27 -3.58 47.45 23.0 304.39 3 2 0 6 302.22 
28 4.38 43.37 7 30 308.37 3 0 0 6 296.30 
29 3.19 80.67 0 310 310.30 5 1 0 6 273.38 
30 2.49 71.44 23.0 308.83 4 1 0 6 281.12 
31 -0.03 78.35 23.0 311.38 5 4 0 3 292.01 
32 0.13 10.49 22.0 318.35 6 4 0 5 264.99 
33 3.75 37.29 17.0 224.25 2 1 0 3 209.87 
34 -2.95 21.43 18.0 233.27 2 0 0 3 223.94 
35 2.68 97.98 20.0 272.25 5 4 0 3 233.92 
36 4.80 26.30 20.0 270.37 2 0 0 6 278.10 
37 3.34 37.29 20.0 266.34 2 1 0 4 260.37 
38 3.08 43.09 19.0 255.29 2 2 0 4 234.87 
39 4.06 17.07 19.0 266.36 1 0 0 3 242.4 
40 4.33 43.37 21.0 280.32 3 0 0 6 263.1 
41 2.86 34.14 19.0 250.29 2 0 0 4 237.39 
42 3.00 77.75 19.0 256.25 4 3 0 3 225.39 
43 3.09 77.15 20.0 272.30 4 3 0 4 248.65 
44 4.43 50.09 21.0 297.74 3 0 0 4 257.79 
45 4.66 26.30 22.0 292.37 2 0 0 4 284.03 
46 5.10 43.37 23.0 308.37 3 0 0 6 296.00 
47 4.11 30.21 19.0 248.28 2 0 0 3 227.41 
48 3.55 17.07 18.0 232.28 1 0 0 3 224.11 
49 4.46 29.96 20.0 326.61 2 0 0 4 254.80 
50 4.35 17.07 17.0 222.28 1 0 0 3 218.41 
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Table - 3 Bioactivity    Score   of   Chalcones    by   Molinspiration Server Molinspiration Bioactivi ty Score v 2011.0 

Ligand GPCR Ligand Ion Channel modulator Kinase Inhibitor Nuclear 
 Receptor ligand 

Protease inhibitor Enzyme Inhibitor 

1 -0.43 -0.18 -0.66 -0.51 -0.60 -0.120 
2 -0.17 -0.13 -0.43 -0.04 -0.30 0.06 
3 -0.01 -0.12 -0.15 0.07 -0.13 0.08 
4 -0.07 -0.12 -0.22 -0.01 -0.18 -0.07 
5 -0.23 -0.27 -0.40 -0.23  -0.40 -0.10 
6 -0.08 -0.22 -0.23 -0.04 -0.18 -0.04 
7 -0.07 -0.04 0.01 0.04 0.03 0.10 
8 0.23 -0.13 -0.31 -0.01 0.32 0.57 
9 0.10 0.30 -0.00 -0.55 -0.16 0.39 
10 -0.05 -0.19 -0.25 -0.05 -0.20 0.01 
11 -0.19 0.02 -0.43 -0.21 -0.41 0.03 
12 -0.20 -0.24 -0.54 -0.36 -0.50 -0.14 
13 -0.17 -0.13 -0.43 -0.04 -0.30 -0.06 
14 -0.38 -0.18 -0.51 -0.24 -0.68 -0.10 
15 -0.12 -0.21 -0.21 -0.35 -0.23 -0.01 
16 -0.28 -0.31 -0.49 -0.42 -0.10 -0.04 
17 -0.03 -0.05 -0.35 -0.09 -0.19 -0.07 
18 -0.49 -0.02 -0.25 -0.58 -0.51 -0.02 
19 -0.32 -0.28 -0.41 -0.51 -0.46 -0.11 
20 -0.07 -0.01 -0.25 -0.01 -0.24 -0.01 
21 -0.26 -0.12 -0.55 -0.28 -0.41 -0.04 
22 -0.34 -0.26 -0.54 -0.34 -0.52 -0.12 
23 -0.21 -0.24 -0.43 -0.14 -0.39 -0.03 
24 -0.09 -0.24 -0.1 -0.12 -0.13 -0.16 
25 0.10 -0.04 -0.14 -0.27 -0.10 0.14 
26 -0.10 -0.32  -0.32 -0.03 -0.32 -0.04 
27 0.03 0.14  -0.32 -0.14 -0.13 -0.01 
28 -0.12 -0.12  -0.42 -0.03 -0.28 -0.08 
29 -0.24 -0.21 -0.34 -0.09 -0.42 -0.09 
30 -0.32 -0.34 -0.68 -0.01 -0.38 -0.06 
31 0.15 -0.01 -0.32 0.32 0.21 0.35 
32 -0.18 -0.22 -0.32 -0.21 0.06 -0.60 
33 -0.29 -0.14 -0.53 -0.23 -0.47 0.02 
34 -0.38 -0.41 -0.38  -0.69 -0.53 -0.11 
35 -0.11 0.02 -0.21 0.11 -0.21 0.13 
36 -0.19 -0.32 -0.63 -03 -033 0.15 
37 0.22 0.13 -0.32 0.38 -0.15 0.49 
38 -0.05 -0.01 -0.21 -0.45 -0.04 -0.08 
39 -0.19 -0.20 -0.56 -0.45 -0.49 -0.03 
40 -0.29 -0.23 -0.48 -0.15 -0.39 -0.15 
41 -0.30 -0.07 -0.57 -0.18 -0.19 -0.01 
42 -0.14 -0.13 -0.3 -0.03 -0.32 -0.07 
43 -0.01 -0.08 -0.32 -0.23 -0.16 0.20 
44 -0.16 -0.18 -0.43 -0.04 -0.41 -0.05 
45 0.17 -0.34 -0.13 -0.14 -0.05 -0.15 
46 -0.07 -0.02 -0.29 0.06 -0.11 -0.01 
47 -0.16 -0.07 -0.42 -0.29 -0.46 -0.04 
48 -0.06 0.18 -0.21 -0.04 -0.25 0.16 
49 -0.14 -0.15 -0.20 -0.29 -0.26 0.18 
50 0.52 -0.27 -0.63 -0.42 -0.71 0.20 
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Table - 4 OSIRIS Property Explorer, 2001-2014 
 

S.No Mutagenic Tumori-genic Irritant Reproductive effective Clogp Solubility Drug likeness Drug-Scroe 
1 No Yes Yes yes 3.3 -3.84 -2.88 0.25 
2 Yes Yes Yes Yes 2.79 -3.85 -4.08 0.41 
3 Yes Yes Yes Yes 2.27 -2.95 -1.98 0.45 
4 Yes Yes Yes Yes 4.15 -5.15 -1.79 0.34 
5 Yes Yes Yes Yes 3.16 -3.88 -0.48 0.55 
6 Yes Yes Yes Yes 4.36 -5.48 -3.21 0.28 
7 Yes Yes Yes Yes 3.92 -5.84 -2.57 o.29 
8 Yes Yes Yes Yes 1.0 -2.57 -0.52 0.62 
9 Yes Yes Yes Yes 2.9 -4.62 -3.27 0.38 
10 Yes Yes Yes Yes 4.43 -5.46 -1.55 0.32 
11 Yes Yes Yes Yes 4.01 -4.65 -7.15 0.34 
12 Yes No Yes Yes 3.99 -4.53 -0.23 0.4 
13 Yes Yes Yes Yes 2.79 -3.85 -2.76 0.43 
14 No Yes No Yes 3.24 -4.16 -3.44 0.25 
15 Yes Yes Yes Yes 3.0 -4.66 -0.39 0.5 
16 Yes Yes Yes Yes 2.67 -4.48 2.03 0.69 
17 Yes Yes Yes Yes 4.46 -4.93 -4.75 0.3 
18 No No Yes Yes 3.68 -5.09 -2.85 0.12 
19 Yes Yes Yes Yes 3.68 -4.73 0.91 0.52 
20 Yes Yes Yes Yes 3.4 -4.15 -1.56 0.45 
21 Yes Yes Yes Yes 4.06 -4.43 -4.1 0.35 
22 Yes Yes Yes Yes 3.23 -3.86 -1.95 0.45 
23 Yes Yes Yes Yes 2.96 -3.59 -0.17 0.6 
24 No Yes Yes Yes 2.38 -5.31 3.5 0.39 
25 Yes Yes Yes Yes 2.22 -3.94 -0.46 0.56 
26 Yes Yes Yes Yes 3.58 -4.25 -2.39 0.4 
27 Yes Yes Yes Yes 3.45 -3.02 -2.37 0.23 
28 Yes Yes Yes Yes 3.86 -5.04 -2.47 0.34 
29 No Yes No Yes 2.8 -4.01 -2.08 0.25 
30 Yes Yes Yes Yes 2.82 -3.78 -8.89 0.29 
31 Yes Yes Yes Yes 2.3 -3.78 -8.89 0.29 
32 Yes Yes Yes Yes 0.09 -3.5 -1.1 0.26 
33 Yes Yes Yes Yes 2.96 -3.54 0.68 0.7 
34 Yes Yes Yes Yes 2.63 -3.92 -1.28 0.5 
35 Yes Yes Yes Yes 1.92 -2.66 0.75 0.75 
36 Yes Yes Yes Yes 4.51 -3.84 -2.22 0.38 
37 Yes Yes Yes Yes 4.0 -4.69 -3.02 0.35 
38 Yes Yes Yes Yes 2.41 -4.11 -4.25 0.41 
39 Yes Yes Yes Yes 4.13 -5.43 -2.21 0.32 
40 Yes Yes Yes Yes 3.22 -3.98 -6.42 0.39 
41 Yes Yes Yes Yes 2.93 -3.49 1.75 0.47 
42 Yes Yes Yes Yes 2.39 -2.82 -1.21 0.55 
43 Yes Yes Yes Yes 2.61 -3.3 0.61 0.71 
44 Yes Yes Yes Yes 4.25 -4.92 0.66 0.52 
45 Yes Yes Yes Yes 4.28 -4.72 -2.03 0.35 
46 Yes Yes Yes Yes 3.22 -3.98 -5.35 0.39 
47 Yes Yes Yes Yes 3.53 -4.21 1.49 0.68 
48 Yes Yes Yes Yes 4.06 -4.34 0.19 0.54 
49 Yes Yes Yes Yes 2.7 -3.41 0.44 0.69 
50 Yes Yes Yes Yes 0.31 -3.96 -0.71 0.5 
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Table - 5: PM3 Optimized formation energy, HOMO, LUMO, Energy gap and Dipole moments of chalcones 
 

Chalcones ∆Hf (Kcal/mol) HOMO(eV) LUMO(eV) Energy gap(eV) Dipole moment (Debye) 
1 -33.64 -0.278790 -0.174999 0.103791 2.550953 

2 -54.77 -0.341274 -0.139516 0.201758 2.437448 
3 -78.06 -0.318498 -0.031199 0.287299 3.109350 
4 -16.50 -0.296348 -0.171305 0.125143 0.125143 2 
5 -26.59 -0.361925 -0.084795 0.27713 0.858642 
6 -91.15 -0.235126 -0.153595 0.081531 2.578658 
7 -45.67 -0.332726 -0.145576 0.18715 5.452380 

8 -91.14 -0.326370 -0.112110 0.21426 2.129281 
9 -126.80 -0.338028 -0.158382 0.179646 3.442248 
10 -18.59 -0.313120 -0.119628 0.193492 4.738250 
11 -54.01 -0.355986 -0.081550 0.274436 2.120210 
12 -23.29 -0.250303 -0.157824 0.092479 1.615520 
13 -54.77 -0.380651 -0.103845 0.276806 2.682996 
14 -10.02 -0.333064 -0.121529 0.211535 5.450866 
15 -14.95 -0.339870 -0.116891 0.222979 3.234436 
16 -47.36 -0.280545 -0.202318 0.078227 2.298701 
17 -215.44 -0.272726 -0.191873 0.080853 1.695944 
18 -48.73 -0.272896 -0.198113 0.074783 3.580324 
19 -102.47 -0.283959 -0.183619 0.10034 3.834756 
20 -25.29 -0.283803 -0.206743 0.07706 3.838540 
21 -35.28 -0.206754 -0.129599 0.077155 2.925652 
22 -41.37 -0.278633 -0.174920 0.103713 2.382405 
23 -56.12 -0.318481 -0.186852 0.131629 1.801943 
24 -12.80 -0.345215 -0.128962 0.216253 2.856004 
25 -68.55 -0.280192 -0.189647 0.090545 3.354541 
26 -27.50 -0.322039 -0.137167 0.184872 1.402617 
27 -94.24 -0.343672 -0.142678 0.200994 2.869612 
28 -13.58 -0.358624 -0.091192 0.267432 4.743726 
29 -124.39 -0.267384 -0.152478 0.114906 1.512335 
30 -70.48 -0.377902 -0.086278 0.291624 9.437332 
31 -193.67 -0.282407 -0.165860 0.116547 2.212802 
32 -32.02 -0.331676 -0.110946 0.22073 0.430831 
33 -60.68 -0.278107 -0.190501 0.087606 2.750078 
34 -77.17 -0.347951 -0.124933 0.223018 1.431386 
35 -136.29 -0.326732 -0.180090 0.146642 5.748661 
36 -109.44 -0.263380 -0.210652 0.052728 3.702630 
37 -204.43 -0.283258 -0.208560 0.074698 4.456464 
38 -114.55 -0.300507 -0.185276 0.115747 3.518350 
39 -33.97 -0.285612 -0.204924 0.080688 3.254241 
40 -35.26 -0.261511 -0.206491 0.05502 4.300598 
41 -26.38 -0.349916 -0.101741 0.451657 2.182341 
42 -98.26 -0.315033 -0.177427 0.137612 2.816507 
43 -31.47 -0.346250 -0.155200 0.19105 3.677993 
44 -45.55 -0.265856 -0.156310 0.109546 5.432599 
45 -72.49 -0.301029 -0.076889 0.22414 0.898030 
46 -137.56 -0.241209 -0.199005 0.042204 5.516168 
47 -21.66 -0.306854 -0.188051 0.118803 2.787110 
48 -85.09 -0.296964 -0.201768 0.095196 2.611681 
49 -84.48 -0.295339 -0.207325 0.088014 8.924567 
50 -119.40 -0.336557 -0.096477 0.24008 1.025770 
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Table - 6: Docking Score of 50 chalcones against COX-1 Receptor by HEX 6.3. 
 

Chalcone No Energy kcal/mol No.of H-bonds No.of rotatable bonds 
1 -182.17 6 3 
2 -190.95 9 3 
3 -207.57 13 7 
4 -189.81 5 3 
5 -197.64 8 4 
6 -181.99 9 4 
7 -208.40 6 5 
8 -177.72 11 7 
9 -198.95 7 6 
10 -194.13 4 4 
11 -183.3 6 5 
12 -169.02 3 3 
13 -177.77 9 5 
14 -176.29 3 4 
15 -184.31 12 4 
16 -198.15 6 4 
17 -187.23 9 3 
18 -194.44 9 4 
19 -198.54 7 4 
20 -194.06 4 4 
21 -182.35 4 4 
22 -174.31 8 3 
23 -183.48 Is

) 

3 
24 -188.10 14 4 
25 -191.24 10 7 
26 -181.44 7 Is

) 

27 -204.19 8 6 
28 -204.00 3 4 
29 -196.48 5 5 
30 -223.70 3 3 
31 -208.43 3 3 
32 -197.90 5 4 
33 -183.99 5 3 
34 -188.17 1 7 
35 -195.05 9 Is

) 

36 -210.06 4 6 
37 -192.38 6 4 
38 -184.28 7 4 
39 -179.19 9 3 
40 -199.88 8 6 
41 -179.64 6 4 
42 -166.11 11 3 
43 -171.81 5 Is

) 

44 -198.02 7 5 
45 -214.78 3 4 
46 -207.79 10 6 
47 -178.23 3 3 
48 -181.74 10 4 
49 -186.42 12 3 
50 -174.74 8 4 

 
Table - 7: List of Hydrogen bonds between chalcones and COX-1 receptor 

 

Chalcone Interaction site 
Hydrogen Bond Between 

Chalcone & Protein 
Bond Distances 

(A0) 
No. of Hydrogen 

Bonds 
7 154 residue of ser 461 residue of gln 47 residue of gys 154 SER  

461 GLN 
47 GYS 

2.141 2.058 2.277 
3 

30 154 residue of ser 154 SER 2.141  
 461 residue of gln 461 GLN 2.058   2 

31 154 residue of ser 154 SER 2.141  
 461 residue of gln 461 GLN 2.058   2 

36 461 residue of gln 461 GLN 2.058   1 
45 83 residue of arg 83 residue of arg 122 residue of asn 

123 residue of leu 124 residue of ile 
83 ARG  
83 ARG 
122 ASN 
 123 LEU 
 124 ILE 

2.117 2.053 2.263 
2.286 2.436 

  5 
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CONCLUSION 
 

In the present work, we describe the naturally available chalcones to prove the importance of the various 
functionalities by in silico docking method with regard to selective inhibition of COX-1 (PDB ID: 1CQE). Naturally 
available chalcone compounds are selected and their docking energy and other parameters are investigated. Among 
the selected 50 chalcones the lowest docking energy was -223.70 Kcal/mol [table 1, fig. 3]. It was concluded that 
naturally available chalcone-30 to inhibit COX-1 than the other selected chalcones. 
 
Cyclooxygenases (COX-1 and COX-2) catalyze the oxygenation of arachidonic acid (AA) to form prostaglandins 
and thromboxane, which mediate a range of physiological and pathophysiological responses. COX-1 dependent 
prostaglandin synthesis has been implicated in many pathophysiological processes including atherosclerosis, 
endothelial dysfunction, neuroinflammation, preterm labor, pain, and cancer. Earlier results indicate that COX-1 is a 
major source of pro-inflammatory PGs in the brains of both LPS-treated mice and mice treated with the 
Parkinsonism-inducing compound. Therefore, COX-1selective inhibitors represent, a potentially useful class of 
drugs that has not been extensively investigated. 
 
COX activity is the main therapeutic target for non-steroidal anti-infammatory drugs. Some inhibitors of COX-1 and 
COX-2 would be less elective at more infamed sites, since the supply of arachidonic acid can determine their 
effectiveness. Chalcone derivatives able to control NO and PG production by mechanisms other than enzyme 
inhibition have a potential role in modulating the inflammatory process. In summary, this study suggests that growth 
inhibitor effect of chalcones against cancer was supported by theoretical results. The Protein-Ligand interaction 
plays a significant role in structure based drug design. The main reason of the computational approach is the 
reduction of cost and time in drug discovery process. Aim of this project was to investigate which was the best 
chalcones that inhibit activity against COX-1 (cyclooxgenase-1). The best binding chalcones identified by best 
binding energies obtained in docking studies of chalcones with COX-1 (PDB ID: 1CQE). 
 
In the present work of Chalcone-30 (1,3-diarylprop-2-en-1-one) have been introduced as selective cyclooxygenase 
inhibitors. Chalcone-30 have the lowest binding energy (-223.70Kcal/mol) among the investigated chalcone, which 
is the best inhibitory activity against COX-1 (PDB ID: 1CQE). 
 
Cancer is the main cause of death in the world. One of the promising strategies in controlling cancer progression is 
considered cancer chemoprevention by taking dietary factors. Chalcones are the main precursor for the biosynthesis 
of flavonoids, which are frequent components of the human diet. Recent studies on biological evaluation of 
chalcones revealed some to be anticancer, anti-inflammatory, antimitotic, anti-tubercular, cardiovascular, cell 
differentiation inducing, nitric oxide regulation modulatory and antihyperglycemicagents. 
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